# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>INTRODUCTION</strong></td>
<td>4</td>
</tr>
<tr>
<td>Additional Information and Resources</td>
<td>5</td>
</tr>
<tr>
<td>Product License Info and Details</td>
<td>5</td>
</tr>
<tr>
<td>Product Support</td>
<td>6</td>
</tr>
<tr>
<td>Hardware, Software and System Requirements</td>
<td>7</td>
</tr>
<tr>
<td><strong>INSTALLING THE GEFOCETS CONNECTOR</strong></td>
<td>7</td>
</tr>
<tr>
<td><strong>AND GEFOCETS INDICES</strong></td>
<td></td>
</tr>
<tr>
<td>Installation of the Geofacets Connector</td>
<td>8</td>
</tr>
<tr>
<td>Validating the Plug-in was Installed Successfully</td>
<td>10</td>
</tr>
<tr>
<td>Downloading and Adding Geofacets Indices to Petrel</td>
<td>12</td>
</tr>
<tr>
<td>Index Authentication</td>
<td>16</td>
</tr>
<tr>
<td>Geofacets Index Updates</td>
<td>16</td>
</tr>
<tr>
<td><strong>UNINSTALLING THE GEFOCETS CONNECTOR</strong></td>
<td>17</td>
</tr>
<tr>
<td><strong>UNINSTALLING AND/OR REMOVING THE GEFOCETS INDICES</strong></td>
<td>18</td>
</tr>
</tbody>
</table>
INTRODUCTION

The Geofacets Connector for Petrel and Studio makes exploration seamless by allowing the content and insights from Geofacets (www.geofacets.com) to be accessible from within the Petrel E&P software platform.

The Geofacets Connector integrates the unique features and functionality of Geofacets directly into Petrel and Studio environments. This allows geoscientists working in exploration to search, discover and integrate hundreds of thousands of scientific maps extracted from peer-reviewed publications into 2D and 3D projects within the Petrel platform, enabling easier validation of proprietary models with external insights, the ability to learn more about the geologic characteristics of an area, and more.

The Geofacets Connector delivers:

- Trusted, curated content base with hundreds of thousands of georeferenced geologic maps sourced from over 61 leading scientific journals and publications in one platform, updated weekly
- Geographic and keyword-based search features that are developed specifically to help geoscientists find relevant content quickly and effectively
- Comprehensive map details and links to associated full-text articles that provide additional insight and context for individual maps
- Ability to save searches and set up alerts that make it easier to stay up-to-date with the most recent published maps and information available

Do more in less time by:

- Gaining greater scientific insights for deeper analysis of exploration opportunities
- Reducing risk by increasing certainty in your interpretations
- Supporting your evaluations and recommendations when you have little or no proprietary data and information
- Spending less time searching and formatting, and more time on interpretation

Accelerate your exploration workflow with Geofacets and the Geofacets Connector for Petrel and Studio.
ADDITIONAL INFORMATION AND RESOURCES

This installation guide provides information about downloading and installing both the plug-in and the associated Geofacets indices.

For additional information about the Geofacets Connector, please visit: www.elsevier.com/gfconnector

PRODUCT LICENSE INFO AND DETAILS

Access and use of the Geofacets Connector requires both a license key for the plug-in and a license or subscription to access and download the associated Geofacets index or indices, which must be licensed in conjunction with the plug-in. This installation guide provides information about downloading and installing both the plug-in and the associated Geofacets indices.

<table>
<thead>
<tr>
<th>PLUG-IN NAME</th>
<th>Geofacets Connector for Petrel and Studio</th>
</tr>
</thead>
<tbody>
<tr>
<td>VENDOR NAME</td>
<td>Elsevier Inc.</td>
</tr>
<tr>
<td>COUNTRY OF ORIGIN</td>
<td>United States</td>
</tr>
<tr>
<td>LICENSE FEATURE NAME</td>
<td>OCEAN_ELS_GEOFACETSCONNECTOR</td>
</tr>
<tr>
<td>PUBLIC KEY TOKEN</td>
<td>6220b9163de04cca</td>
</tr>
</tbody>
</table>
PRODUCT SUPPORT

If you have problems installing the *Geofacets Connector*, please contact one of the following support centers in your region:

<table>
<thead>
<tr>
<th>EUROPE, MIDDLE EAST &amp; AFRICA</th>
<th>NORTH, CENTRAL AMERICA &amp; CANADA</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email:</strong> <a href="mailto:nlinfo@elsevier.com">nlinfo@elsevier.com</a></td>
<td><strong>Email:</strong> <a href="mailto:usinfo@elsevier.com">usinfo@elsevier.com</a></td>
</tr>
<tr>
<td><strong>Tel:</strong> +31 20 485 3767</td>
<td><strong>Tel:</strong> +1 888 615 4500</td>
</tr>
<tr>
<td><strong>Fax:</strong> +31 20 485 3739</td>
<td><strong>Fax:</strong> +1 212 462 1974</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ASIA &amp; AUSTRALIA</th>
<th>JAPAN</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email:</strong> <a href="mailto:sginfo@elsevier.com">sginfo@elsevier.com</a></td>
<td><strong>Email:</strong> <a href="mailto:jpinfo@elsevier.com">jpinfo@elsevier.com</a></td>
</tr>
<tr>
<td><strong>Tel:</strong> +65 6349 0222</td>
<td><strong>Tel:</strong> +81 (3) 5561 5035</td>
</tr>
<tr>
<td><strong>Fax:</strong> +65 6733 1050</td>
<td><strong>Fax:</strong> +81 (3) 5561 0451</td>
</tr>
</tbody>
</table>
INSTALLING THE GEOFACETS CONNECTOR AND GEOFACETS INDICES

Before starting the installation process for the Geofacets Connector and the associated Geofacets indices, please make sure that the appropriate version of Petrel is running on your computer.

The installation process for the Geofacets Connector is a two-step process. The first step requires downloading the plug-in and the second step requires downloading the index or indices that your company has subscribed to.

The Geofacets Connector for Petrel and/or Studio requires a license key available from the Ocean Store website (www.ocean.slb.com). This license is administered in the same way as the license for Petrel or other Petrel plug-ins and is available as msi file from the Ocean Store website (www.ocean.slb.com).

HARDWARE, SOFTWARE AND SYSTEM REQUIREMENTS

To install and run the plug-in, you will require:

- Installation of Petrel 2013.X 64-bit (see release notes for supported versions)
- Identical hardware, software, operating system requirements to run the Petrel (e.g., versions of Windows, .NET etc.)
- Valid Petrel license stored locally or on a license server
- Valid license and subscription for Geofacets Connector and Geofacets
- Registration name and password for Geofacets (www.geofacets.com)
- 25GB free disk space (if store locally) or network space for saving Geofacets indices

In addition, at a minimum, we suggest having a valid Petrel Geoscience Core license. If you have questions about the hardware, software, and operating requirements of the Petrel E&P platform, please consult the Petrel Installation Guide for more information.
**INSTALLATION OF THE GEOFACETS CONNECTOR**

To get started using the *Geofacets Connector* for Petrel and Studio, please follow the installation instructions provided below:

1. On a target PC, that meets the prerequisites (see the Hardware, Software and System Requirements section of this installation guide), the installation process can start at Step 4; otherwise Steps 2 and 3 must be completed before the plug-in is installed.

2. Install the Petrel application.

3. Once you have installed Petrel and Schlumberger Licensing utility 2013, open Petrel 2013.

   **NOTE:** Please follow your site policy on installing the plug-in license alongside your Petrel license. Describing the many ways that Petrel licenses can be configured is beyond the scope of this document, but at a minimum you will need to add the plug-in license to the file, file list or folder containing your Petrel license in the Schlumberger licensing utility.

4. Double click the *GeofacetsConnectorInstaller.MSI* in windows explorer.

5. Click the next button on the “Welcome to the Geofacets Connector Setup Wizard” dialog box.

6. Click the next button on the “Confirm Installation” dialog box.

   **NOTE:** You may receive popup box asking to allow Elsevier to install application, Click YES.

7. Click the next button on the “Geofacets Connector Information” dialog box.

8. Click the close button on “Installation Complete” dialog box.

9. Installation is now complete.
Welcome to the Geofacets Connector Setup Wizard

The installer will guide you through the steps required to install Geofacets Connector on your computer.

WARNING: This computer program is protected by copyright law and international treaties. Unauthorized duplication or distribution of this program, or any portion thereof, may result in severe civil or criminal penalties, and will be prosecuted to the maximum extent possible under the law.

Install Geofacets Connector Information

Click “Next” to complete the installation of the plug-in.

To complete the installation process, you must go to the following URL to register and download the Geofacets index: http://www.geofacets.com/plugin-registration

Please refer to the installation guide for complete installation instructions.

Confirm Installation

This installer is ready to install Geofacets Connector on your computer.

Click “Next” to start the installation.

Installation Complete

Geofacets Connector has been successfully installed.

Click “Close” to exit.

Please use Windows Update to check for any critical updates to the .NET Framework.
VALIDATING THE PLUG-IN WAS INSTALLED SUCCESSFULLY

The following section describes the procedure for checking that the Geofacets Connector for Petrel 2013 has been successfully installed. There are two ways to verify that the plug-in has been correctly installed.

1. From within Petrel, open the Ocean Plug-in Manager from the Help menu. From the Ocean Plug-in Manager you should see the following plug-ins listed in the dialog window:
   - Geofacets Connector for Petrel and Studio
   - The Globe for Petrel

2. Clicking on the green check-mark icon expands the plug-in window to display the details of the plug-in.

3. In addition, the default location for the Geofacets Connector plug-in files will be: C:\Program Files\Schlumberger\Petrel 2013\Extensions (although this may be different on your PC).

4. Within the “Extensions” folder, check that there are four folders present, and that their contents are as follows:

   ![Folder contents screenshot]
INSTALLATION OF THE GEOFACETS CONNECTOR (CMD SHELL)

1. Click on windows start button and type “cmd”, and press enter.

2. Execute command: “msiexec /i “C:\[plugin_name].msi”
   (note your location of the plugin may be different).

3. Follow windows prompt to complete installation.
Welcome to the Geofacets Connector Setup Wizard

The installer will guide you through the steps required to install Geofacets Connector on your computer.

WARNING: This computer program is protected by copyright law and international treaties. Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil or criminal penalties, and will be prosecuted to the maximum extent possible under the law.
DOWNLOADING AND ADDING GEOFACTS INDICES TO PETREL

Access and use of the Geofacets Connector requires both a license key for the plug-in and a license or subscription to access and download the associated Geofacets Index or indices, which must be licensed in conjunction with the plug-in.

1. To download your licensed Geofacets Index or Indices, please go to the Geofacets Connector Registration Page at http://www.geofacets.com/plugin-registration.

2. Complete the Registration Form and click ‘Register’ at the bottom of the page. Required fields are indicated with a red asterisk (*).

   **NOTE:** You will not be able to access and download the Geofacets Indices without completing the registration form.

3. Click on ‘My Indexes’ in the top right corner of the Geofacets home page, if it does not open automatically upon successful registration.

4. Download the listed index .zip files (e.g., Elsevier, SEPM Society for Sedimentary Geology, etc).

   **NOTE:** ONLY the indices for which you are licensed to download will appear in the My Indexes dialog.
5 The download time will greatly vary depending on the publisher and your bandwidth.

6 After each index has been successfully downloaded, extract the index and save to preferred location on your local drive or network drive.
To add the newly downloaded indices to your search settings within Petrel, open Petrel and go to File > Options > Search Settings.

Click the 'Create a new local index' button in the Search Settings dialog:

Navigate to the folder where the indices were saved, select the index you wish to load (filename.index), and click 'OK'.

Enter the index name, exactly as the file index is named in the Index Name field and click 'OK'.

The index will be added to the Search Settings. Complete this for each and every index that you would like to enable in your search.

Verify that there is a green marker under index 'Status' and that the 'Search enabled' box is checked before closing the Search Settings window.
NOTE: A red marker under ‘Status’ for a given index indicates that there is a problem with the connection to the index or the index has not loaded properly.

Click ‘close’ to return to your Petrel project window to start using the Geofacets Connector plug-in.
INDEX AUTHENTICATION

One of the most valuable features of the plug-in is the ability to load relevant maps from the Geofacets Indices to your Petrel project. Note that the first time a user tries to load a map to a Petrel project from the index, the user will be required to login to Geofacets using their registration username and password.

All persons downloading the indices and all persons using the indices will be required to register with Geofacets. This is a one-time registration that enables:

- Users to download the index
- Access Geofacets.com from within Petrel, and
- Set-up of personalized alerts and notifications when Geofacets adds new map content

For more information about how to get started using the plug-in and more detailed information about the various features and functionality, please consult the Geofacets Connector User Guide.

GEOFACETS INDEX UPDATES

The Geofacets Indices are updated on a weekly basis; approximately 500 maps are added each week across all indices.

Users will be notified on a monthly basis when a newly updated index is available for download from www.geofacets.com.
UNINSTALLING THE GEOFACETS CONNECTOR

1. To uninstall the plug-in, open up the Control Panel from your Windows Start Up Menu.

2. Open Programs and Features (Windows 7) and select the Geofacets Connector.

3. Confirm that you want to uninstall to uninstall the plug-in to being the uninstall process.
UNINSTALLING AND/OR REMOVING THE GEOFACETS INDICES

1. To uninstall or remove the Geofacets Indices from Petrel, open Petrel and go to File > Options > Search Settings.

2. Select the index that you would like to remove or delete and click the ‘Remove or delete selected index(es)’ button.

3. Confirm that you want to delete the selected index by clicking ‘Yes’.

4. Once the index is deleted, it will no longer be listed in the ‘Search Settings’ dialog. Click close to return to your Petrel project.
<table>
<thead>
<tr>
<th>Status</th>
<th>Index name</th>
<th>Path</th>
<th>Search enabled</th>
<th>Default index</th>
<th>Number of projects</th>
<th>Number of Items</th>
<th>Last indexed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Geoacrt</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SEG</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SEPM</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SWAB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Search settings**

**Index filter:** All

**Status:**

- Default
- Geoacrt
- SEG
- SEPM
- SWAB

**Index name**

- Geoacrt
- SEG
- SEPM
- SWAB

**Path**

- C:sers\mcmellbop\AppData\Local\Schlumberger
- C:sers\mcmellbop\MyIndex\Geoacrt\Geoacrt.idx
- C:sers\mcmellbop\MyIndex\SEG\SEG.idx
- C:sers\mcmellbop\MyIndex\SEPM\SEPM.idx
- C:sers\mcmellbop\MyIndex\SWAB\SWAB.idx

**Search enabled**

- Check box

**Default index**

- None

**Number of projects**

- 1

**Number of Items**

- 1

**Last indexed**

- 06/30/2014 16:40:44

**Please confirm**

Do you want to delete the underlying index information?

**NOTE:** all searchable information will be lost.

**Yes**

**No**

**Double-click the row to view or edit the index**

**Close**
UNINSTALL OF THE GEOFACETS CONNECTOR (CMD SHELL)

1. Click on windows start button and type “cmd”, and press enter.

2. Execute command: “msiexec /x “C:\[plugin_name].msi”
   (note your location of the plugin may be different).

3. Follow windows prompt to complete uninstall.
C:\Windows\system32\cmd.exe

Microsoft Windows [Version 6.1.7601]
Copyright (c) 2009 Microsoft Corporation. All rights reserved.

C:\Users\USER1> msiexec /i "C:\Users\USER1\GeofacetsConnectorInstaller.msi"

C:\Users\USER1> msiexec /x "C:\Users\USER1\GeofacetsConnectorInstaller.msi"

C:\Users\USER1>

Windows Installer

Are you sure you want to uninstall this product?

Yes  No